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1. Introduction

Overview

This Customer Software Release Supplement (CSRS) is issued
with DigiPath 4.1 to provide customers with DigiPath information
specific to this release of software. This document is a true
supplement to the Customer Software Release Document
(CSRD) which was issued with DigiPath 4.0, and should be read
in conjunction with that document. This is the only customer
documentation issued with DigiPath 4.1 software.

In this introductory chapter you will find a software compatibility
matrix for DigiPath 4.1 and a list of production printers supported
for use with DigiPath 4.1. In the following chapters you will learn
about what is new in DigiPath 4.1, updates that have been made
to your DigiPath documentation and about Hints and Tips which
apply in this software version.
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Hardware components

This section contains the required hardware components for the
DigiPath 4.1 workstation and server configurations.

DigiPath 4.1 workstation platform

Table 1-1 lists the required hardware components for the
workstation platform of the following DigiPath workstation

configurations:
* DigiPath Xpress

+ DigiPath Professional Document Scan and Makeready

Table 1-1. Workstation platform required hardware

components

Digipath 4.1
workstation platform

Description

Dell Precision 650

The DigiPath 4.1 workstation platform consists

of:

2.8 GHz Intel Xeon P4-Class CPU

1 GB of memory

Dual 120 GB ATA-100 7200 RPM Hard
Disks

AGP Graphics Slot w/Nvidia Quadro FX500
64 MB Graphics Controller

Adaptec Dual Port 39160 SCSI Adapter
Card

TR5 10/20 GB Tape Drive

V90 56K PCIl Modem

1.44 MB Floppy Disk

48x/24x/48x CD-RW

10Base/T-100/1.0 GB Base-TX Network
Controller

5 PCI Slots (3* PCIx 64b/100 MHz, 2 * 32b/
33 MHz)

Microsoft Windows XP Professional
operating system

Microsoft Internet Explorer

Dell P1130 21 inch
monitor

DigiPath 4.1 supports the 21 inch color monitor.
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DigiPath 4.1 server platform

Table 1-2 lists the required hardware components for the server
platform of the following DigiPath Professional server
configurations:

* Document Library server
»  Web Services server

Table 1-2. Server platform required hardware components

Digipath 4.1 server

platform Description
Compag W8000 The DigiPath Professional server platform
consists of:

* Dual 2.2 GHz Intel Xeon P4-Class CPUs

*+ 1.5 GB of memory

+ Dual 18 GB 15K RPM SCSI Hard Disks

* AGP Graphics Slot w/Nvidia Quadro 2EX
Graphics Controller

+ TR510/20 GB Tape Drive

V90 56K PCI Modem

* 1.44 MB Floppy Disk

*+ 48x CD-ROM

* Integrated Intel PRO/100+ Management
Adapter

+ 6 PCI Slots (2 PCIx 64b/66 MHZ, 4 * 32b/
33 MHz)

*  Microsoft Windows Server 2003 Server
Standard Edition operating system

*  Microsoft Internet Explorer

Compaqg P1220 21 inch | The DigiPath Professional supports the 21 inch
monitor color monitor.
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Print server compatibility matrix

<]

NOTE: This table of supported production printers replaces the
table of supported production printers on page 1-15 of the
DigiPath Production Software Customer Software Release
Document, Version 4.0

This section provides a list of supported production printers, local
printers, updated print paths for DigiPath 4.1, and compatible
printers supported with DigiPath 4.1.

Supported production printers

<]

Table 1 lists the supported production printers for use with
DigiPath 4.1.

NOTE: The following abbreviations represent different DigiPath
applications:

DL — Document Library

* DSM — Document Scan and Makeready
* QP — Quick Print

+ S&P — Scan and Print

WS — DigiPath Web Services

CUSTOMER SOFTWARE RELEASE SUPPLEMENT
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Table 1. Supported production printers

Printer

Configuration/Revision Level

DigiPath Application

DocuTech / DocuPrint 65

DocuSP 2.0 (TCP/IP) (Netware)
DocuSP 2.1 (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS

DocuTech / DocuPrint 75

DL, DSM, QP, S&P, WS

DocuTech / DocuPrint 90

( (
( (
DocuSP 3.7 (TCP/IP) (Netware)
DocuSP 3.8 (TCP/IP) (Netware)
( (
(

DocuSP 3.7 (TCP/IP) (Netware)
DocuSP 3.8 (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS

DocuStation DP 301

Print Services 1.x (TCP/IP)

DL, DSM, QP, S&P

DocuTech 135

Network Server (TCP/IP) (Netware)
Network Server J 1.4.0 (TCP/IP)
NS Plus 2.1 (TCP/IP)

NS+ Server Series 4.x (TCP/IP)

DL, DSM, QP, S&P, WS

DocuTech Publisher —
6100
6115
6135
6155
6180

DocuSP 3.7 (TCP/IP) (Netware)

DocuSP 3.8 (TCP/IP) (Netware)

DocuSP 1.4J (TCP/IP) (Netware) for 6135/
6180 only

DL, DSM, QP, S&P, WS

Xerox DocuTech 100/120
C/P

DocuSP Server 4.0 (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS

DocuPrint with NPS
server

DocuPrint 92C
DocuPrint 96

DocuPrint 180
DocuPrint 4050
DocuPrint 4090
DocuPrint 4635
DocuPrint 4850
DocuPrint 4890

DocuPrint Server (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS

DocuPrint with DocuSP

DocuPrint 100
DocuPrint 115
DocuPrint 135
DocuPrint 155
DocuPrint 180

DocuSP 3.7 (TCP/IP) (Netware)
DocuSP 3.8 (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS
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Table 1. Supported production printers

Printer

Configuration/Revision Level

DigiPath Application

DocuPrint Continuous
Feed

DocuPrint 350/700
DocuPrint 500/1000
DocuPrint 425/850 —
DocuSP 3.8 only

DocuSP 3.7 (TCP/IP)
DocuSP 3.8 (TCP/IP)

DL, DSM, QP, S&P, WS

EX2101

EFI V2.0 (TCP/IP)

DL, DSM, QP, S&P, WS

DocuColor 2045/2060

EFI (TCP/IP)

CSX2000 V2.0 (TCP/IP)
DocuSP 3.7 (TCP/IP) (Netware)
DocuSP 3.8 (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS

Document Centre —
220/230/240/255/265

Document Centre —
332/340

Document Centre —
420/432/440/460/470/480/
490

TCP/IP

DL, DSM, QP, S&P, WS

DocuColor 6060 DocuSP Server 3.8 (TCP/IP) (Netware) DL, DSM, QP, S&P, WS
EXP6000 V2.0 (TCP/IP)
CXP6000 V3.0 (TCP/IP)

DocuColor 5252 DocuSP Server 3.8 (TCP/IP) (Netware) DL, DSM, QP, S&P, WS

CXP6000 V3.0 (TCP/IP)
EFI Server 1.21A (TCP/IP)

DocuColor iGen3

Creo Spire Server (TCP/IP)
DocuSP Server 3.8 (TCP/IP) (Netware)

DL, DSM, QP, S&P, WS

Generic PostScript Printer

TCP/IP

DL, DSM, QP, S&P, WS

Extended Connectivity Print | EC-PJM 1.3 DL, DSM, QP, S&P, WS
Job Manager (EC-PJM) EC-PJM 2.0
Xerox Docudob Converter XDJC 21 DL, DSM, QP, S&P
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G NOTE: Novell Netware configurations do not support RDO
printing, except for legacy Network Server to DocuTech 135.

Compatible printers supported with DigiPath 4.1

Table 2 lists the compatible printers that are supported with
DigiPath 4.1 and the supported print path to use.

Table 2. Compatible printers

Compatible printer / DFE Supported print path to use

DocuColor 12 with EFI DocuColor 2060:EFI

CUSTOMER SOFTWARE RELEASE SUPPLEMENT 1-7
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2. New features

Overview

This section describes the new features and functionality of the
DigiPath 4.1 Production Software.
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Software

This section introduces new software that is supported by
DigiPath 4.1.

Hummingbird NFS Maestro Server

Hummingbird NFS Maestro Server 8.0 software is now provided
along with the Hummingbird NFS Maestro Client software to
support VIPP workflows.

Contact your Xerox Representative for more information on
Hummingbird NFS Maestro software.
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Standalone Quick Print

The Quick Print application is now available as a Standalone
Quick Print application. Contact your Xerox Representative for
information on ordering the Standalone Quick print application.

The Standalone Quick Print application is a full featured print
utility that allows the comprehensive programming of printing
attributes for a broad array of Xerox Production Printing and
Publishing devices.

The Standalone Quick Print application allows you to program
basic printing features, selective page programming, notes and
special instructions, page inserts, covers, image quality
adjustments, full Xerox Job Ticketing, and more. The selected
printer determines the extensibility of the printer features
displayed. You also have the ability to concatenate jobs together
to form a single job with a single job ticket or multiple jobs with
similar printing attributes for each job. Mixed jobs of varying print
ready formats may also be concatenated.

The Standalone Quick Print application provides a method to
access print ready documents and submit them as one job for
printing.

The system requirements for the DigiPath 4.x Standalone Quick
Print application are as follows:

« 733 MHz CPU

* Windows XP Professional operating system

+ 256 MB RAM minimum

« 200 MB of free hard drive space for application installation
» Free hard drive space for application use

G NOTE: The space required for application use is dependent
on the size of the jobs.
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For more information on using the DigiPath 4.x Standalone
Quick Print application, refer to:

+ DigiPath 4.x Quick Print online Help system

» DigiPath 4.x Standalone Quick Print READ ME FIRST letter,
701P41088 contained in the DigiPath 4.x Standalone Quick
Print Kit, 701S01854
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Converting documents to PDF

The PDF Conversion feature is an accessory of the DigiPath 4.1
software that enables you to convert the following document
types to Adobe PDF for viewing and/or printing; MS Office,
Photoshop, JPG, BMP, TIFF, and text.

G NOTE: Contact your Xerox Representative for more information
on the PDF conversion feature.

You must have the following third-party software installed on
your DigiPath machine to convert the following document types
to viewable PDF and/or printable PDF renditions:

« Conversion of MS Office document requires MS Office 2003.
Xerox does not provide MS Office 2003.

» Conversion of Photoshop documents requires Photoshop CS

1 3. Complete the following procedure for all DigiPath 4.1 systems
that have PDF Conversion:

1. Select [Start: Settings: Printers and Faxes] from the desktop.

2. Highlight Acrobat Distiller and select [Printing Preferences]
from the right mouse menu options. The Acrobat Distiller
Printing Preferences dialog opens.

3. Select the [Adobe PDF Settings] tab.

4. Clear the [Do not send fonts to Distiller] check box.
5. Select [Apply].

6. Close the Printers and Faxes window.

If you have the PDF Conversion feature, the following sections
provide detailed procedures for scheduling viewable and/or
printable PDF conversion in Library Administration Tool,
converting/viewing the converted Adobe PDF documents in
Document Library, DigiPath Web Services, Library Search, and
Batch Tool, and printing the converted printable Adobe PDF
documents using Quick Print.
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Scheduling viewable and/or printable PDF conversion in LAT

Use the Conversion tab in Library Administration Tool to
schedule viewable and/or printable PDF conversion for all
Document Library cabinets, on a per server basis. Use the
following PDF conversion options to specify viewable and
printable PDF conversion in LAT:

» The Printable PDF Conversion option allows you to enable
the batch conversion service to create printable Adobe PDF
renditions of all documents that you want converted to Adobe
PDF in the repository. The converted printable Adobe PDF
can be printed via Production Print or Quick Print.

+ The Viewable PDF Conversion option allows you to enable
the batch conversion service to create a viewable Adobe
PDF rendition of all documents that you want converted to
Adobe PDF in the repository. The converted viewable PDF
renditions are viewable in the Preview Pane in Document
Library.

2-6
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1 3. To schedule viewable and/or printable PDF conversion in Library
Administration Tool:

1.

Select [Start: Programs: Xerox DigiPath Production Software:
Library Administration Tool] from the Windows desktop.

2. Log into Library Administration Tool.

From the servers drop-down list, select the local or remote
server you want to enable printable PDF conversion.

4. Select the [Conversion] tab.

Mark the [Viewable PDF Conversion] check box to view
converted Adobe PDF documents.

Mark the [Printable PDF Conversion] check box to enable
printable PDF conversion.

Specify any other document conversion settings as desired.

NOTE: For more information on using document conversion,
refer to the DigiPath online Help system.

8. Select [Apply] to apply the conversion settings.

9. Select [File: Exit] to close the Library Administration Tool.
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PDF conversion in Document Library

PDF conversion in Document Library enables you to dynamically
convert or schedule the conversion of non-print ready
documents in the repository to viewable and/or printable PDF
documents. The converted viewable PDF renditions are
viewable in the Preview Pane. The converted printable PDF
renditions are printable through production printing and/or Quick
Print. A copy of the printable PDF rendition can be saved to a
specified location for later use.

1 3. To convert non-print ready documents to viewable and/or

printable Adobe PDF documents in Document Library:

1.

Select [Start: Programs: Xerox DigiPath Production Software:
Document Library] from the Windows desktop.

2. Log into Document Library.

Select the desired non-print ready document from the
repository.

. Select [File: Convert] from the main menu. The Convert

dialog displays.

Mark the [Viewable PDF Conversion] check box to view
converted Adobe PDF documents

Mark the [Printable PDF conversion] check box to convert the
document to a printable PDF.

2-8
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7. Select the Save copy to [...] button to choose the location you
want to save the converted PDF. The Choose Location dialog
box displays.

a. Select the cabinet to which the converted PDF should be
placed.

b. Select [OK]. The Convert dialog box displays and the
location displays in the Save copy to text box.

8. Specify any other conversion options.

G NOTE: You may schedule the document for conversion at a
specific date and/or time.

9. Select [OK] to close the Convert dialog box and convert the
document. The converted PDF displays in the Preview Pane
in Document Library.

<|:| NOTE: To view converted PDF documents, you must have
the Preview Pane enabled. Select [View: Preview Pane] from
the main menu to enable the Preview Pane.

CUSTOMER SOFTWARE RELEASE SUPPLEMENT 2-9
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PDF conversion in Library Search

PDF conversion in Library Search allows you to search on a non-
print ready document in the repository, then convert the
document to viewable and/or printable PDF documents. The
converted viewable PDF renditions are viewable in the Preview
Pane of Document Library. The converted printable PDF
renditions are printable through production printing and/or Quick
Print. A copy of the printable PDF rendition can be saved to a
specified location for later use.

1 3. To convert non-print ready documents to viewable and/or
printable PDF renditions in Library Search:

1. Select [Start: Programs: Xerox DigiPath Production Software:
Library Search] from the Windows desktop.

2. Log into Library Search.

3. Perform a search on the desired non-print ready
document(s).

4. In the Search results, highlight the non-print ready
document(s), and select [Convert] from the context-sensitive
menu. The Convert dialog displays.

G NOTE: The [Convert] option is only available in the context-
sensitive menu which is accessed by right-clicking of the
mouse on the highlighted job.

5. Mark the [Viewable PDF Conversion] check box to view
converted Adobe PDF documents

6. Mark the [Printable PDF conversion] check box to convert the
document to a printable PDF.
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7. Select the Save copy to [...] button to choose the location you
want to save the converted PDF. The Choose Location dialog
box displays
a. Select the cabinet to which the converted PDF should be

placed.

b. Select [OK]. The Convert dialog box displays and the
location displays in the Save copy to text box.

8. Specify any other conversion options.

G NOTE: You may schedule the document for conversion at a
specific date and/or time.

9. Select [OK] to close the Convert dialog box and convert the
document. The converted PDF displays.

T]:l NOTE: To view converted PDF documents, you must have
the Preview Pane enabled. Select [View: Preview Pane] from
the task bar to enable the Preview Pane.
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PDF conversion in Batch Tool

PDF conversion in Batch Tool allows you convert a non-print
ready document in the repository, then convert the document to
viewable and/or printable PDF documents. The converted
viewable PDF renditions are viewable in the Preview Pane of
Document Library. The converted printable PDF renditions are
printable through production printing and/or Quick Print. A copy
of the printable PDF rendition can be saved to a specified
location for later use.

1 3. To convert a non-print ready document to a viewable and/or
printable PDF rendition in Batch Tool:

1.

Select [Start: Programs: Xerox DigiPath Production Software:
Batch Tool] from the Windows desktop.

2. Log into Batch Tool.

Select [Job: Add: Convert] from the main menu. The Convert
dialog displays.

. Mark the [Viewable PDF Conversion] check box to view

converted Adobe PDF documents

Mark the [Printable PDF conversion] check box to convert the
document to a printable Adobe PDF.

Select the Save copy to [...] button to choose the location you
want to save the converted PDF. The Choose Location dialog
box displays

a. Select the cabinet to which the converted PDF should be
placed.

b. Select [OK]. The Convert dialog box displays and the
location displays in the Save copy to text box.

Specify any other conversion options.

NOTE: You may schedule the document for conversion at a
specific date and/or time.

. Add the document from the repository that you wish to

convert by selecting the [Add] icon in the documents list box.
Select [OK] to close the Convert dialog box.

2-12
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Printing a converted PDF document in Quick Print

1, To print a converted PDF document in Quick Print:

1. Select [Start: Programs: Xerox DigiPath Production Software:
Quick Print] from the Windows desktop. The Quick print
application opens.

2. In the Input area, select the document you wish to print.

G NOTE: You can select a document that has already been
converted or, a document that has not been converted. If you
select a document that has not been converted, the
document will automatically be converted before printing. The
converted PDF is not saved.

3. Specify other print options as desired.
4. Select [Print]. The document is successfully printed.
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Printing multiple converted PDF documents in Quick Print

1

2

3.

To print multiple converted Adobe PDF documents in Quick
Print:

1.

N o g o~

Select [Start: Programs: Xerox DigiPath Production Software:
Quick Print] from the Windows desktop. The Quick print
application opens.

In the Input area, select the document you wish to print.

NOTE: You can select a document that has already been
converted or, a document that has not been converted. If you
select a document that has not been converted, the
document will automatically be converted before printing. The
converted PDF is not saved.

Mark the [List multiple files to print] check box to print multiple
documents as a single job.

Mark the [Print as one job] radio button.

Select [Add] to add the selected documents to the job.
Specify other print options as desired.

Select [Print] to submit the documents to the specified
production printer.

2-14
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PDF conversion in DigiPath Web Services

PDF conversion in DigiPath Web Services enables you to
dynamically convert non-print ready documents in the repository
to viewable and/or printable PDF documents.

* The converted viewable PDF documents are viewable in both
the Online Library and when submitting a job for print.

* The converted printable PDF documents are printable
through print submission in Print Documents from Your
Computer and Print Document from Online Library. When
submitting a converted document to print, the printable PDF
document is submitted to the printer.

Specify the following Document Configuration options for
viewable and printable PDF conversion:

+ Specify the document conversion settings on the Conversion
Service page.

» Specify the document viewing options on the View
Configuration page if you want a viewable PDF document
created.
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Print Documents from Your Computer

To view and print a converted Adobe PDF document from Print
Documents from Your Computer:

1.
2.

Open your web browser.

If necessary, enter the URL for the desired DigiPath WS
server.

From the DigiPath WS home page, login to the DigiPath WS
application using the appropriate Username and Password.
Then select [Login]. The Print Document page displays.

NOTE: If the Print Document page does not display, select
[Print Document] from the Navigation bar.

Select [Start Order] in the Print Documents from Your
Computer section. The Select a Document page opens.

In step 1, select the non-print ready document you wish to
submit.

In step 2, select [Upload] to upload the document.

A PDF Status message box opens displaying the status of
the PDF conversion progress displaying the following icons:

+ Upload icon - Displays during the upload process. When
upload is complete, the blue check mark appears above
the icon and the icon changes from grayed out to colored.

* Import icon - Displays during the import process. When
import is complete, the blue check mark appears above
the icon and the icon changes from grayed out to colored.

« Converticon - Displays during the convert process. When
conversion is complete, the blue check mark appears
above the icon and the icon changes from grayed out to
colored.

This PDF Status message dialog automatically closes when
the processing completes.
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7. In the Document Uploaded section, select the document title
to view the converted PDF document. The Viewing
Document page opens with the selected document.

G NOTE: An underlined document title indicates that the
document is viewable. A non-underlined document title
indicates that the document is not viewable.

a. Select [Done] to close the Document Viewing page and
return to the Select a Document page.

G NOTE: A check in the Previewed column indicates that
the document has been viewed.

8. Mark the [Approve all documents for print] check box to
approve all documents for printing.

G NOTE: If you do not select this check box before printing, an
error message displays when you continue the submit
process. You must approve all documents for printing before
you continue in the process.

9. If you have a step 3, select the print queue to which you want
to submit your document(s).

T]:l NOTE: Step 3 is available only for users assigned the
advanced print options.
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10. Select [Continue].

11.In the Job Setup page, enter the appropriate job setup
information and select [Continue].

G NOTE: An underlined document title indicates that the
document is viewable. Select the underlined document title to
view the document in the Viewing Document page. Then,
select [Done] to return to the Job Setup page and continue
processing the job.

12.In the Delivery page, enter the appropriate delivery
information and select [Continue].

13.In the Order Summary page, verify that your document, print
options, delivery, and billing information are correct. Select

[Confirm] to submit your job.

14.From the Receipt Page, print the receipt for your records and
select [Done].
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Setting Opacity when inserting Shared Files

You can now set the opacity when inserting a shared image from
file by selecting Opaque or Transparent options in the Opacity
section of the Shared Image dialog.

The Opacity setting has the following limitations:

The Transparency option is not available for color or
grayscale images including TIFF files, JPEG files, or images
embedded in PS and PDF files.

The Transparency and Opaque options are not available for
Insert File, Insert scanned images, or insertion via drag and
drop.

Transparency does not get preserved for GIF files pasted
from the clipboard.

Transparency does not get preserved for color or grayscale
images pasted from Adobe Photoshop.

Transparency does not get preserved for monochrome TIFF
images that are exported.
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3. Documentation Updates

Overview

This section contains documentation updates which include a
detailed procedure for using Windows Update to install critical
Microsoft Windows updates on your DigiPath 4.1 system.
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Using Windows Update

It is recommended that you use Microsoft’s Inherent Windows
Update capability to install critical Microsoft Windows updates on
your DigiPath 4.1 system.

The details surrounding this process are as follows:

Only critical individual and cumulative updates are approved
for download via Windows Update. This includes updates for
the operating system., supported DigiPath release versions
of Internet Explorer, IS, and VM.

New Service Packs and applicable non-critical patches will
still require formal approval by DigiPath and should only be
installed by a Xerox Representative.

When appropriate, special announcement bulletins will be
distributed for security issues requiring immediate
communication. Critical security information will also be
captured on the www.xerox.com/security web site per the
Carnegie Mellon University CERT/CC advisories.

On a monthly basis, a summary of DigiPath applicable critical
Microsoft security patches that should have been installed on
your DigiPath system will be communicated on the
www.xerox.com/security web site under “Other Security
News and Advisories”.

Each DigiPath site should determine who is responsible for
routinely running Windows Update. Due to the time criticality
of installing many of the Microsoft patches, it is
recommended that the customer perform this task.
Customers requiring Xerox assistance to install updates per
Windows Update should contact the hotline or make
arrangements with their Xerox Representative.

Microsoft Update may need to be run multiple times to install
all eligible updates.
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1 3. To run Windows Update on your DigiPath 4.1 system:

1. Create a new Microsoft System Restore point.

a.

b.
C.
d.

Select [Start: Programs: Accessories: System Tools:
System Restore] from the desktop. The Welcome to
Restore window opens.

Mark the [Create a restore point] radio button.
Select [Next].
Follow the instructions to create a new restore point.

2. Ensure that a full TapeWare system backup exists.

3. On a weekly basis, run Microsoft Windows Update.

a.
b.

Log into the system using the DPAdmin account.

Use the DigiPath batch utility to stop the DigiPath
services.

i. Select [Start: Run] from the Windows desktop. The
Run dialog box opens.

ii. Inthe Open text box, enter e:\digipath\xstopdgp.bat
iii. Select [OK] to run the batch file.
iv. Reply [Y] to all queries.

Open Internet Explorer and select [Tools: Windows
Update] from main menu.

If the Security Warning window opens to install the latest
Windows Update software, select [Yes] to install and run
Windows Update.

In the Microsoft Windows Update page, select the [Scan
for Updates] link in the center of the page.
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In the left Windows Update tree, select [Critical Updates
and Service Packs]. The Critical Updates and Service
Packs page opens in the right window pane.

. Select the [Review and install updates] link.

. Remove any service packs from the list of downloads.

NOTE: Microsoft operating system and Internet Explorer
service packs are not to be installed via this process.

Select [Install Now] to download all Microsoft critical
updates needed for your system.

Select [Accept] to accept the Microsoft license
agreement. The update will be downloaded and installed.

If prompted, select [OK] to restart your system.

NOTE: Restarting the system will also restart the
DigiPath services.
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Hints and Tips

The Hints and Tips in this section have been written to support
the launch of DigiPath 4.1 Production Software. They are
arranged according to DigiPath application. Look for the potential
problem and the conditions creating the problem. Look, too, for
ways to avoid the problem and ways to recover.
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Installation/System/Migration

Administrator Notes not migrating

Condition = When migrating from a DigiPath 3.0.x WVS system to a DigiPath
4.0 WS system, the Administrator Notes from the Administrator
Options page do not migrate.

Workaround Re-enter the Administrator Notes in the Administrator Options
page on the DigiPath 4.x WS system.

Avoidance Migrate from the base level of DigiPath 3.0 WVS to DigiPath 4.x
WS system.

DigiPath 4.1 Web Services (WS)

Collection descriptions not reflected in exported reports

Condition = When exporting data from the Collection report, the collection
description does not display in the exported report.

Workaround Run the Collection report via DigiPath WS to view the collection
descriptions.

4-2 CUSTOMER SOFTWARE RELEASE SUPPLEMENT



XEROX DIGIPATH PRODUCTION SOFTWARE HINTS AND TIPS

Condition

Workaround

Condition

Workaround

Avoidance

Print queue options return to default

After selecting the [Back] button on the Job Setup page, the
printer queue information is set back to the default printer queue
instead of the printer queue that you would like to print to.

Re-select the print queue that you want to print your document
to.

Files names have .aspx extension

When using the Netscape browser on a Windows platform to
download a document from the Online Library, the document
downloads with an .aspx extension.

When prompted for the file name, remove the .aspx file
extension from the suggested file name.

Use either Microsoft Internet Explorer on windows operating
system or use Netscape on LINUX operating system.
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Condition

Workaround

1 3
2

Condition

Workaround

Avoidance

404.3 error message displays

When viewing a non-supported file type, you may receive a
404.3 “The page cannot be found.” error message.

Add the file name extension to the defined MIME Type in IIS for
the non-supported file type by completing the following:

NOTE: You must be a member of the Administrator group on the
local computer to perform the following procedure.

1. Right-click on [My Computer], and select [Manage]. The
Computer Manager console opens.

2. Expand [Services and Applications].

3. Highlight [Internet Information Services (11S) Manager], and
select [Properties] from the right mouse menu options. The
Internet Information Services (IIS) Manager Properties dialog
box opens.

4. Refer to the online Help in 1IS (1IS) Manager for procedures
on adding MIME Types and add the correct MIME Type for
the non-supported file type. Search on “Working with MIME
Type”. in the IIS (IIS) manager online help system.

Variable Scaling should not be allowed for any signature or
n-up jobs

When selecting a document to be a signature job or a 4/8/16 up
job, the Scale To field is not disabled, which should be disabled.
If you select the [Continue] button an error message displays
letting you know that you must correct the error before continuing
to the next page.

Change the Job Type to Standard Job Type. Or, de-select
Variable Scaling.

Do not program Variable Scaling for any signature Job Types or
4/8/16 up jobs in WS Job Setup.
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Document Library

Condition

Workaround

Condition

Workaround

Avoidance

PDF conversion not working

When converting non-print ready documents, MS Word, Excel,
and Power Point, the viewable and printable PDF conversions
fails.

Complete the following procedure for all DigiPath 4.1 systems
that have PDF Conversion:

1. Select [Start: Settings: Printers and Faxes] from the desktop.

2. Highlight Acrobat Distiller and select [Printing Preferences]
from the right mouse menu options. The Acrobat Distiller
Printing Preferences dialog opens.

Select the [Adobe PDF Settings] tab.
Clear the [Do not send fonts to Distiller] check box.

Select [Apply].

o 0 kW

Close the Printers and Faxes window.

Enumeration request not satisfied during concurrency test

During Document Library enumeration concurrency testing, the
clients intermittently do not return from the request to enumerate
a directory. The application status at the bottom of the dialog
does not refresh to indicate the number of objects retrieved.

Select another folder or refresh to update the application status
to reflect the number of jobs retrieved.

Do not run concurrent enumeration.
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Condition

Workaround

Condition

Workaround

Avoidance

Unable to move or copy a document from the
MainCollection into a shortcut folder

When trying to move or copy a document from the
MainCollection into a shortcut folder, the document does not
move or copy.

Do not copy or move documents into a shortcut folder.

Cannot import files that have an “=" in the name

“_n

When trying to import a file with an “=” in the file name, a
“‘Database error” message displays and the file will not import.

({3 )

Import files that do not contain the “=" character in the file name.

“ ”

Do not use an “=” in a file name that you want to import.
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Document Scan and Makeready (DSM)

Condition

Workaround

Condition

Avoidance

Condition

Workaround

Avoidance

Selecting a page after a selected tag selects a tag

In the Structure window, a tag is also selected when selecting
pages after that tag.

When an extra section is also selected, re-select the first page of
the selection desired.

Subset finishing preview of landscape is incorrect

The staples being displayed in DSM to represent the subset
finishing are not exactly how the final printed output’s staples
display.

Do not save the job ticket information into the document or
ignore the preview of the staple placement.

Incorrect menu item displays

When the cursor is highlighting or placed over a menu item, then
using [Alt] + [F] to expand the File menu displays the Options
menu.

Select the File menu using the mouse.

Make sure the cursor is not highlighting or placed over any other
menu item when using [Alt] + [F] to select the File menu.
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Condition

Workaround

Condition

Workaround

Avoidance

Condition

Workaround

Avoidance

Some colors do not display as expected

When inserting a fill and changing the fill type to colorized, some
colors do not display as expected.

Use the Custom Color Picker to select the appropriate color.

Fusing an RDO on a remote client does not work

When opening an RDO on a remote client, fusing of a page does
not work.

Copy the RDO to the local system or local cabinet, then open the
RDO and perform the fuse.

Do not fuse an RDO on a remote client.

Edit/Share feature not working correctly

The “Remove the shared item from any pages not specified
above” feature is not working correctly. The original shared item
is not deleted.

Select the shared image in the Structure Window that you would
like to remove and then select [Edit: Delete].

Do not use the “Remove the shared item from any pages not
specified above” option to delete shared images.
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Condition

Workaround

Condition

Workaround

Condition

Avoidance

Page numbers are not updated

Page numbers are not updated when applied to multiple sections
at the same time.

Use the Page Numbering wizard so the page numbers are
updated for all sections.

Paper stock not changing for paired pages

The paper stock is not changing for paired pages when the
second page is changed first.

Select both the first paired pages and second paired pages.
Then, change the paper stock so they are the same.

Linked images become unlinked

Linked images inserted into a PDF page become unlinked once
the page is reassembled.

Do not link images into PDF pages.
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Condition

Workaround

Condition

Workaround

Avoidance

Sections are being applied to every page

When using the Format/Headers/Footers/Page Numbers wizard,
sections are applied to every page when attempting to apply a
range of pages.

Select the pages you would like to create a section of in the
Structure window. Then, select [Insert: Tag Section].

Edit mode places blue crop lines in the wrong position

When edit mode and rescan are used together, the new portion
of the image may have the wrong orientation, or have distorted
scaling.

In DSM select the image without enabling Edit mode, then place
the new image on the scan bed to make sure the image is
updated, and rescan the image.

Do not use Edit mode and rescan together.
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Scan and Print

Condition

Workaround

Condition

Workaround

Same as original stock size incorrect

When switching between multiple custom original page sizes
with [Same as original] as the output stock, the resulting output
paper size does not change.

Select the same target custom size two consecutive times.

Location text box not editable

The Location text box should be an editable text box.

Use the [Browse] button to locate and select the save location.

DigiPath Scanner

Condition

Workaround

Optimize Image not updating

The Optimize Image does not update the resolution field for
which different printers are optimized.

After changing the printer selection, check the displayed
resolution value. If necessary, change the value.
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Xerox Doculmage 620S Scanner

Condition

Workaround

Scanned image not displaying with DL Light Image

When scanning an image with DL Light Image as the Original
Type, the scanned image does not display.

Change the Original Type to “Course Halftone” and adjust the
brightness setting to -10 to produce a readable scanned image.

Production Printing

Condition

Workaround

Condition

Workaround

Avoidance

Print Status and Print Submission completed do not display

The Print Status window and Print Submission Completed do not
display when printing from DigiPath File Manager.

The Print Completion dialog is behind the main DigiPath File
Manager window when a file is selected for Production Print. You
can either minimize or move the DigiPath File Manager window
to see the Print Submit Complete notification.

PostScript files not printing in Batch Tool or DL

PostScript files that are generated in DSM do not print through
Batch Tool or Document Library when printing to the DocuTech
135 NS+ Server series 4.0 production printer.

Import the PostScript file into DSM and print through DSM.

Do not print PostScript files created in DSM through Batch Tool
or Document Library on a DocuTech 135 NS+ Server Series 4.0
production printer.
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GDI Printing

Enable background printing does not work

Condition = When selecting the “Enable background printing” option in DSM
Options: Settings: Printing in DSM does not work.

Workaround Select a Xerox High Speed PostScript Generation printer for
faster processing of jobs.

Avoidance Do not select the “Enable background printing” option.

Job Manager

Job Manager did not display the correct Printer Status
information

Condition Job Manager displays a “Paused” message instead of the
current message that is displayed at the IGEN3 server/printer.

Workaround Go to the IGEN3 printer to determine what particular attention
the printer needs.

Output Location in Job Manager is different from DocuSP
Queue Manager

Condition In DigiPath, the value for Output Location is System Specified
while in DocuSP Queue Manager, the value for Output Location
is Top Tray.

Workaround Check the Queue Properties at the DocuSP to verify that the
Output Location is set to System Specified.

CUSTOMER SOFTWARE RELEASE SUPPLEMENT 4-13



HINTS AND TIPS

XEROX DIGIPATH PRODUCTION SOFTWARE

4-14

CUSTOMER SOFTWARE RELEASE SUPPLEMENT






	Xerox DigiPath Production Software
	Xerox DigiPath Production Software
	Customer Software Release Supplement
	701P41346
	Version 4.1 
	February, 2004
	Xerox Corporation
	Xerox Corporation
	Global Knowledge and Language Services
	800 Phillips Road - Bldg. 845-17S
	Webster, NY 14580

	Copyright © 1996-2004 Xerox Corporation. All rights reserved. XEROX®, The Document Company® and all identifying numbers used in ...
	Copyright © 1996-2004 Xerox Corporation. All rights reserved. XEROX®, The Document Company® and all identifying numbers used in ...
	While every care has been taken in the preparation of this material, no liability will be accepted by Xerox Corporation arising out of any inaccuracies or omissions.
	Printed in the United States of America.

	Xerox®, Xerox Canada Ltd®, Xerox Limited®, and all Xerox products mentioned in this publication are trademarks of Xerox Corporation. Other company trademarks are acknowledged as follows:
	Xerox®, Xerox Canada Ltd®, Xerox Limited®, and all Xerox products mentioned in this publication are trademarks of Xerox Corporation. Other company trademarks are acknowledged as follows:
	Adaptec®, the Adaptec logo, SCSlSelect®, and EZ-SCSI® are trademarks of Adaptec, Inc
	Adobe PDFL - Adobe PDF Library Copyright © 1987-2002 Adobe Systems Incorporated
	Adobe®, Acrobat®, the Acrobat logo, Acrobat Exchange®, Distiller®, and PostScript® are registered trademarks of Adobe Systems Incorporated.
	Copyright 1987 - 2001 Adobe Systems Incorporated and its licensors. All rights reserved.
	Autologic® is a registered trademark of Autologic Information International, Inc.
	Compaq® and QVision® are registered United Staten Patent and Trademark Office, for Compaq Computer Corporation.
	DEC, DEC RAID, and Redundant Array of Independent Disks are registered trademarks of Digital Equipment Corporation.
	Dundas - This software contains material that is © 1997-2000 DUNDAS SOFTWARE LTD., all rights reserved.
	Hummingbird NFS Maestro® is a registered trademark of Hummingbird Communications, Ltd. 
	Imaging Technology provided under license by Accusoft Corporation.
	ImageGear © 1996-2001 by AccuSoft Corporation. All Rights Reserved.
	Intel® and Pentium® are registered trademarks of Intel Corporation.
	Novell® and NetWare® are registered trademarks of Novell, Inc. in the United States and other countries.
	Oracle® is a registered trademark of Oracle Corporation Redwood City, California
	Outside In® Viewer Technology © 1992-2000 IntraNet Solutions Chicago, Inc. All rights reserved.
	TMSSequoia - ScanFix ® Image Optimizer Copyright © TMSSEQUOIA, Inc. 1991-2000. All rights reserved.
	Sony™ and Storage by Sony™ are trademarks of Sony.
	Stellent - Outside In® Viewer Technology© 1992-2002 Stellent Chicago, Inc. All rights reserved.
	StorageView™ is a trademark of CMD Technology, Inc.
	TextBridge® is a Registered Trademark of ScanSoft, Inc.
	TIFF® is a registered trademark of Aldus Corporation.
	Windows™ , Windows NT™ , Windows 2000 Professional, Windows 2000 Professional Server, Windows XP, Windows Server 2003, and Inter...
	This product includes software developed by the Apache Software Foundation.
	This software is based in part on the work of Graeme W. Gill.
	Includes Adobe® PDF Library technology
	Portions contain an implementation of the LZW algorithm licensed under U.S. Patent 4,558,302
	All non-Xerox brands and product names are trademarks or registered trademarks of their respective companies.
	Changes are periodically made to this document. Changes, technical inaccuracies, and typographical errors will be corrected in subsequent editions. 


	Table of contents
	1. Introduction 1-1
	2. New features 2-1
	3. Documentation Updates 3-1
	4. Hints and Tips 4-1
	1. Introduction
	Overview 
	Hardware components
	DigiPath 4.1 workstation platform
	DigiPath 4.1 server platform


	Print server compatibility matrix 
	Supported production printers
	Compatible printers supported with DigiPath 4.1


	2. New features
	Overview
	Software
	Hummingbird NFS Maestro Server

	Standalone Quick Print
	Converting documents to PDF
	Scheduling viewable and/or printable PDF conversion in LAT
	PDF conversion in Document Library
	PDF conversion in Library Search
	PDF conversion in Batch Tool
	Printing a converted PDF document in Quick Print
	Printing multiple converted PDF documents in Quick Print
	PDF conversion in DigiPath Web Services
	Print Documents from Your Computer


	Setting Opacity when inserting Shared Files

	3. Documentation Updates
	Overview
	Using Windows Update


	The Hints and Tips in this section have been written to support the launch of DigiPath 4.1 Production Software. They are arrange...
	Installation/System/Migration
	Administrator Notes not migrating
	Condition


	When migrating from a DigiPath 3.0.x WVS system to a DigiPath 4.0 WS system, the Administrator Notes from the Administrator Options page do not migrate.
	Workaround

	Re-enter the Administrator Notes in the Administrator Options page on the DigiPath 4.x WS system.
	Avoidance

	Migrate from the base level of DigiPath 3.0 WVS to DigiPath 4.x WS system.
	DigiPath 4.1 Web Services (WS)
	Collection descriptions not reflected in exported reports
	Condition


	When exporting data from the Collection report, the collection description does not display in the exported report.
	Workaround

	Run the Collection report via DigiPath WS to view the collection descriptions.
	Print queue options return to default
	Condition

	After selecting the [Back] button on the Job Setup page, the printer queue information is set back to the default printer queue instead of the printer queue that you would like to print to.
	Workaround

	Re-select the print queue that you want to print your document to.
	Files names have .aspx extension
	Condition

	When using the Netscape browser on a Windows platform to download a document from the Online Library, the document downloads with an .aspx extension.
	Workaround

	When prompted for the file name, remove the .aspx file extension from the suggested file name.
	Avoidance

	Use either Microsoft Internet Explorer on windows operating system or use Netscape on LINUX operating system.
	404.3 error message displays
	Condition

	When viewing a non-supported file type, you may receive a 404.3 “The page cannot be found.” error message.
	Workaround

	Add the file name extension to the defined MIME Type in IIS for the non-supported file type by completing the following:
	NOTE:
	You must be a member of the Administrator group on the local computer to perform the following procedure.
	1. Right-click on [My Computer], and select [Manage]. The Computer Manager console opens.
	2. Expand [Services and Applications].
	3. Highlight [Internet Information Services (IIS) Manager], and select [Properties] from the right mouse menu options. The Internet Information Services (IIS) Manager Properties dialog box opens.
	4. Refer to the online Help in IIS (IIS) Manager for procedures on adding MIME Types and add the correct MIME Type for the non-supported file type. Search on “Working with MIME Type”. in the IIS (IIS) manager online help system.
	Variable Scaling should not be allowed for any signature or n-up jobs
	Condition

	When selecting a document to be a signature job or a 4/8/16 up job, the Scale To field is not disabled, which should be disabled...
	Workaround

	Change the Job Type to Standard Job Type. Or, de-select Variable Scaling.
	Avoidance

	Do not program Variable Scaling for any signature Job Types or 4/8/16 up jobs in WS Job Setup.
	Document Library
	PDF conversion not working
	Condition


	When converting non-print ready documents, MS Word, Excel, and Power Point, the viewable and printable PDF conversions fails.
	Workaround

	Complete the following procedure for all DigiPath 4.1 systems that have PDF Conversion:
	1. Select [Start: Settings: Printers and Faxes] from the desktop.
	2. Highlight Acrobat Distiller and select [Printing Preferences] from the right mouse menu options. The Acrobat Distiller Printing Preferences dialog opens.
	3. Select the [Adobe PDF Settings] tab.
	4. Clear the [Do not send fonts to Distiller] check box.
	5. Select [Apply].
	6. Close the Printers and Faxes window.
	Enumeration request not satisfied during concurrency test
	Condition

	During Document Library enumeration concurrency testing, the clients intermittently do not return from the request to enumerate a directory. The application status at the bottom of the dialog does not refresh to indicate the number of objects retrieved.
	Workaround

	Select another folder or refresh to update the application status to reflect the number of jobs retrieved.
	Avoidance

	Do not run concurrent enumeration.
	Unable to move or copy a document from the MainCollection into a shortcut folder
	Condition

	When trying to move or copy a document from the MainCollection into a shortcut folder, the document does not move or copy.
	Workaround

	Do not copy or move documents into a shortcut folder.
	Cannot import files that have an “=” in the name
	Condition

	When trying to import a file with an “=” in the file name, a “Database error” message displays and the file will not import.
	Workaround

	Import files that do not contain the “=” character in the file name.
	Avoidance

	Do not use an “=” in a file name that you want to import.
	Document Scan and Makeready (DSM)
	Selecting a page after a selected tag selects a tag
	Condition


	In the Structure window, a tag is also selected when selecting pages after that tag.
	Workaround

	When an extra section is also selected, re-select the first page of the selection desired.
	Subset finishing preview of landscape is incorrect
	Condition

	The staples being displayed in DSM to represent the subset finishing are not exactly how the final printed output’s staples display.
	Avoidance

	Do not save the job ticket information into the document or ignore the preview of the staple placement.
	Incorrect menu item displays
	Condition

	When the cursor is highlighting or placed over a menu item, then using [Alt] + [F] to expand the File menu displays the Options menu.
	Workaround

	Select the File menu using the mouse.
	Avoidance

	Make sure the cursor is not highlighting or placed over any other menu item when using [Alt] + [F] to select the File menu.
	Some colors do not display as expected
	Condition

	When inserting a fill and changing the fill type to colorized, some colors do not display as expected.
	Workaround

	Use the Custom Color Picker to select the appropriate color.
	Fusing an RDO on a remote client does not work
	Condition

	When opening an RDO on a remote client, fusing of a page does not work.
	Workaround

	Copy the RDO to the local system or local cabinet, then open the RDO and perform the fuse.
	Avoidance

	Do not fuse an RDO on a remote client.
	Edit/Share feature not working correctly
	Condition

	The “Remove the shared item from any pages not specified above” feature is not working correctly. The original shared item is not deleted.
	Workaround

	Select the shared image in the Structure Window that you would like to remove and then select [Edit: Delete].
	Avoidance

	Do not use the “Remove the shared item from any pages not specified above” option to delete shared images.
	Page numbers are not updated
	Condition

	Page numbers are not updated when applied to multiple sections at the same time.
	Workaround

	Use the Page Numbering wizard so the page numbers are updated for all sections.
	Paper stock not changing for paired pages
	Condition

	The paper stock is not changing for paired pages when the second page is changed first.
	Workaround

	Select both the first paired pages and second paired pages. Then, change the paper stock so they are the same.
	Linked images become unlinked
	Condition

	Linked images inserted into a PDF page become unlinked once the page is reassembled.
	Avoidance

	Do not link images into PDF pages.
	Sections are being applied to every page
	Condition

	When using the Format/Headers/Footers/Page Numbers wizard, sections are applied to every page when attempting to apply a range of pages.
	Workaround

	Select the pages you would like to create a section of in the Structure window. Then, select [Insert: Tag Section].
	Edit mode places blue crop lines in the wrong position
	Condition

	When edit mode and rescan are used together, the new portion of the image may have the wrong orientation, or have distorted scaling.
	Workaround

	In DSM select the image without enabling Edit mode, then place the new image on the scan bed to make sure the image is updated, and rescan the image.
	Avoidance

	Do not use Edit mode and rescan together.
	Scan and Print
	Same as original stock size incorrect
	Condition


	When switching between multiple custom original page sizes with [Same as original] as the output stock, the resulting output paper size does not change.
	Workaround

	Select the same target custom size two consecutive times.
	Location text box not editable
	Condition

	The Location text box should be an editable text box.
	Workaround

	Use the [Browse] button to locate and select the save location.
	DigiPath Scanner
	Optimize Image not updating
	Condition


	The Optimize Image does not update the resolution field for which different printers are optimized.
	Workaround

	After changing the printer selection, check the displayed resolution value. If necessary, change the value.
	Xerox DocuImage 620S Scanner
	Scanned image not displaying with DL Light Image
	Condition


	When scanning an image with DL Light Image as the Original Type, the scanned image does not display.
	Workaround

	Change the Original Type to “Course Halftone” and adjust the brightness setting to -10 to produce a readable scanned image.
	Production Printing
	Print Status and Print Submission completed do not display
	Condition


	The Print Status window and Print Submission Completed do not display when printing from DigiPath File Manager.
	Workaround

	The Print Completion dialog is behind the main DigiPath File Manager window when a file is selected for Production Print. You can either minimize or move the DigiPath File Manager window to see the Print Submit Complete notification.
	PostScript files not printing in Batch Tool or DL
	Condition

	PostScript files that are generated in DSM do not print through Batch Tool or Document Library when printing to the DocuTech 135 NS+ Server series 4.0 production printer.
	Workaround

	Import the PostScript file into DSM and print through DSM.
	Avoidance

	Do not print PostScript files created in DSM through Batch Tool or Document Library on a DocuTech 135 NS+ Server Series 4.0 production printer.
	GDI Printing
	Enable background printing does not work
	Condition


	When selecting the “Enable background printing” option in DSM Options: Settings: Printing in DSM does not work.
	Workaround

	Select a Xerox High Speed PostScript Generation printer for faster processing of jobs.
	Avoidance

	Do not select the “Enable background printing” option.
	Job Manager
	Job Manager did not display the correct Printer Status information
	Condition


	Job Manager displays a “Paused” message instead of the current message that is displayed at the IGEN3 server/printer.
	Workaround

	Go to the IGEN3 printer to determine what particular attention the printer needs.
	Output Location in Job Manager is different from DocuSP Queue Manager
	Condition

	In DigiPath, the value for Output Location is System Specified while in DocuSP Queue Manager, the value for Output Location is Top Tray.
	Workaround

	Check the Queue Properties at the DocuSP to verify that the Output Location is set to System Specified.

